Quick-start tutorial

IN THIS CHAPTER

» Exercise 1: Displaying and
exploring your data

e Exercise 2: Finding a site for a
new school

» Exercise 3: Finding an alternative
route to the new school site

With Spatial Analyst you can easily perform spatial analysis on your data.
You can provide answers to simple spatial questions, such as “How steep is
it at this location?” or “What direction is this location facing?”, or you can
find answers to more complex spatial questions such as “Where is the best
location for a new facility?” or “What is the least-cost path from A to B?”
When used in conjunction with ArcMap, Spatial Analyst provides a compre-
hensive set of tools for exploring and analyzing your spatial data, enabling
you to find solutions to your spatial problems.

Tutorial scenario

The town of Stowe, Vermont, USA, has experienced a substantial increase
in population. Demographic data suggests this increase has occurred due to
families with children moving to the region, taking advantage of the many
recreational facilities located nearby. It has been decided that a new school
must be built to take the strain off the existing schools, and as a town
planner you have been assigned the task of finding the potential sites.

Spatial Analyst provides the tools to find an answer to such spatial prob-
lems. This tutorial will show you how to use some of these tools and will
give you a solid basis from which you can start to think about how to solve
your own specific spatial problems.
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It is assumed that you have installed the Spatial Analyst
extension before you begin this tutorial. The data required
is included on the Spatial Analyst installation disk (the
default installation path is ArcGIS\ArcTutor\Spatial, on the
drive where the tutorial data is installed). The datasets were
provided courtesy of the State of Vermont for use in this
tutorial. The tutorial scenario is fictitious, and the original
data has been adapted for the purpose of the tutorial.

The datasets are:

Dataset Description

Elevation Raster dataset of the elevation of the arca

Landuse Raster dataset of the landuse types over the
area

Roads Feature dataset displaying linear road
network

Rec_sites Feature dataset displaying point locations
of recreation sites

Schools Feature dataset displaying point locations
of existing schools

Destination Feature dataset displaying the destination

point for use in finding the shortest path

In this tutorial you will first explore your data to learn
more about it and to understand its relationships. Then, you
will find suitable locations for the new school, based on the
fact that it is preferable to locate close to recreational
facilities for ease of access to these places for the children,
and it is also important to locate away from existing
schools to spread their locations over the town. You also
want to avoid steep slopes and certain landuse types.
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Once you have found the best sites, you will examine these
locations to see which is potentially the most suitable. You
will then examine the data to see if any problems may arise
from building the school in the chosen location.

This tutorial is divided into exercises and is designed to let
you explore the functionality of Spatial Analyst at your
own pace.

* Exercise 1 shows you how to display and explore your
data using the functionality of ArcMap and Spatial
Analyst. You will add and display your datasets, high-
light values on the map, identify locations to obtain
values, examine a histogram, and create a hillshade.

» Exercise 2 helps you to find the best location for a new
school by creating a suitability map. You will derive
datasets of distance and slope, reclassify datasets to a
common scale, weight those that are more important to
consider, then combine the datasets to find the most
suitable locations.

» Exercise 3 shows you how to find an alternative route
(the least-cost, or shortest path) for a road to the new
school site.

Copies of the results obtained from each exercise are stored
in the Results folder on your local drive where you in-
stalled the tutorial data (the default installation path is
ArcGIS\ArcTutor\Spatial\Results).

You will need about one hour of focused time to complete
the tutorial. However, you can perform the exercises one at
a time if you wish, saving your results along the way when
recommended.
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Exercise 1: Displaying and exploring your data

You should explore your data to understand it and to
identify relationships. Understanding your data and recog-
nizing relationships will enable you to more accurately

prepare your data for analysis.

In this exercise, you will open ArcMap and add the Spatial
Analyst toolbar to your ArcMap session. You will then
explore your datasets using functionality within ArcMap

and Spatial Analyst.

Starting ArcMap and Spatial Analyst

1. Start ArcMap by either double-clicking a shortcut
installed on your desktop or using the Programs list in

your Start menu.

2. Click OK to open a new empty map.

& ArcMap | |

— Start uzing Arckd ap with

for various geographic regions.

é A existing map:

Templates provide ready-to-uze layouts and base maps

Browse for maps...
C:hzpatialS patial_T utorial mxd

I Immediately add data
[~ Do not show thiz dialog again

—©

3. Click View, point to Toolbars, and click Spatial Analyst.

QUICK-START TUTORIAL

File Edit | VWiew Inzert Selection Toolz Window Help

m D ata View
m Layout Wiew

Zoom Data »

Zoom Lapout »

Eookmarks 3

Toolbars 4 |T Main Menu
E Table Of Contents ’7 Standard
|T Status Bar Toals

Deverflow Labels.. |T Diraw

Identify Results... Layout
E Serollbars Spatial &nalyst |—e
N Effects

E ditar

The Spatial Analyst toolbar is added to your ArcMap
session.

Spatial Analyst

Spatial Analyst * | [Layer: I

Enabling the Spatial Analyst toolbar

1. Click the Tools menu.

2. Click Extensions and check Spatial Analyst.
. Click Close.

98]
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Adding data to your ArcMap session
1. Click the Add Data button on the Standard toolbar.

Standard

DEEE| 5 BB | | [Fm 5
1

2. Navigate to the folder on your local drive where you
installed the tutorial data (the default installation path is
ArcGIS\ArcTutor\Spatial, on the drive where the tutorial
data is installed).

Click elevation, press and hold down the Shift key, then
click landuse, rec_sites, roads, and schools.

4. Click Add.

W

Mame: |e\evatian; landuze; rec_sites. shp: roads.shp: schools, shp Add

Shaw of ype: IDatasets and Layers [*lur]

j Cancel
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The datasets are added to the ArcMap table of contents
as layers.

B £ Layers
B M schaals

@
B M rec_sites

@
E M roads
E M landuse
WALUE
=1
[ M
m:
w4
/s
&
| K
E M elevation
Walue
High : 4361

Low: 435

Displaying and exploring data
You will now explore the display capabilities of ArcMap
by changing the symbology of some of the layers.

1. Right-click landuse in the table of contents and click
Properties.

[ £F Layers
= 0 schoals

®

=0 rec_sites
®

= roads

= - la

- = Capy

= * Bemove

= Open attribute Table

= Joinz and Relates »
= @ Zoom Ta Layer

= @Q Zoom To Raster Resolution
= ele Wisible Scale Range 3

Set Data Source..

l Save As Layer File
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2. Click the Symbology tab.

All landuse categories are currently drawn using cell
values as the Value Field and in random colors. You will
change the Value Field to be more meaningful and
change the color of each symbol to show a more appro-
priate color for each landuse on the map.
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. Click the Value Field dropdown arrow and click
Landuse.

4. Double-click each symbol and choose a suitable color to
represent each landuse type.

5. Click OK.

Layer Properties

General| Souce | Evtent| Display - Symbelony | Fiekss |
Show:

| Draw raster assigning a color to

Classified
Stretched Walue Field

ach value

Colar Schem;

[—---

Symbol | WALUE>

[ Label

| Count |

(I <l other values>
<Heading>

E—

<all other valuess

Landuse
Berieuilhie

[ Mo Calor

d

85054
]

Insitional 234

36034
EF1722
EZ2187
12241

ﬂ Default Colors I

Digplay MoData as \'I

Mare Colars.

J Cacel Al

The changes you make are reflected in the table of contents

and in the map.

QUICK-START TUTORIAL

You can also change the color and properties of symbols
via the table of contents.

6. Click the point representing schools in the table of
contents.

|%

ER=1 Layers
= schoals
@
= rec_sites
®

L

7. Scroll to the School 2 symbol and click it.
8. Click the color dropdown arrow and click a color.
9. Click OK.

& * i+
Aghenitk J Agtenh & School 1
'y + T
Schodl 2 Arpler Aifiekd
® @
Hordcmped 1 Handicapped 2
I
@ - s, e
Hodgtal 1 Momdd 2 Inisstae w1 ] ok _Cwed | [

@ o

The changes you make are reflected in the table of contents
and in the map.
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Highlighting a selection on the map

Examining the attribute table gives you an idea of the

number of cells of each attribute in the dataset.

1. Right-click landuse in the table of contents and click

Open Attribute Table.

x|
£ £F Layers |

E|

L: 52 Copy

g ¥ Bemaove
Bz
g En Open Attribute Table

[ B Juins and Relates 3
M Fo

- @ Zoom To Layer
1w @2 Zoom Ta Raster Rezolution

Notice that Forest (value of 6) has the largest count,

followed by Agriculture (value of 5), then Water

(value of 2).

£ Attributes of landuse

ObjectlD™ | Yalue Count Landuse
234 | Brush/transitional
E2187 W ater
28 |Barren land
36034 | Built up
85054 | Agriculture
E71722 |Forest

12241 |'wetlands

Fiecord il;l 1 _Plﬂl Shnw‘W SEIecledl Fecords [0 out of 7 Selected ]

L3

| mfen| | o ma | =
~|m|o| e =

IM[=1 E3

Optiohs =

2. Click the row representing Wetlands (value of 7).
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B Attributes of landuse

ObjectiD* | Value

Count Landuse

294 | Bruzh/transitional

E2187 [\ ater

28| Barren land

36034 | Builk up

85054 | Agriculture

E71722 | Forest

A R R Y
I LN

12241 |'wietlands

Recard: ili" 1 _Dlﬂl Show:W Selectedl Recards

This selected set, all areas of Wetlands, is highlighted on
the map.

3. Click the Options button on the Open Attribute Table
dialog, then click Clear Selection.

Options = I I

@& Find & Replace...

5_ Select By Attributes. ..

Select &l

ion

Switch Selection

Add Field...

Felated Tables »

Create Graph...
Add Table to Layout

Reload Cache

]

Expatt...

Appearance...

4. Click the Close button to close the Attributes of landuse

table.
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Identifying features on the map

1. Click the Identify tool on the Tools toolbar.

2. Click the Rec_site shown in the map below to identify
the features in this particular location.

Note: Your display will not be zoomed in this much; this

is only to show the location of the recreation site to
click.

. Click the Layers dropdown arrow on the Identify
Results dialog box and click All layers.

W

4. Click the Rec_site again to identify the features in this
particular location for all layers.

5. Expand the tree of each layer to obtain the value for
each layer in this location.

6. Close the Identify Results dialog box.

QUICK-START TUTORIAL

5 3 6
|dentify, Results
Layerd |<AII layersy j
|Location: (477313 S06366 225636 936307)

W ountain Besort: Field | Value | :I
=N FID_1 20 I— |
¢ [ MOUNTAIN RESORT RD | Shape Faint

= landuse FID 35

. ®m5 AREA 1]

E| elevation FERIMETER o

) M&P 30021
1513 SITE_MAME Stowe Mountain Fesart

FIPS_CODE 15040
ALT_MAME
S_ADDRESS 5781 Mountain Road j

Using Spatial Analyst to explore your data

You will now create a histogram from the landuse layer
and a hillshade from the Elevation layer to gain more of an
understanding of the nature of the landscape.

Setting the analysis properties

Before you use Spatial Analyst, you should set up the
analysis options, stating the working directory, the extent,
and the cell size for your analysis results. These settings are
specified in the Options dialog box.
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1. Click the Spatial Analyst dropdown arrow and click
Options.

" General |Extent| CellSizeI

|Spatia| Analyst | Layer: Ielavation
1 wiorking directony:

Distance 3

Diensity £
Analyziz mazk: |<N0ne> x l D|

Interpolate to R aster 3

Surface Analysis g Analysiz Coordinate Sypstem

Call Statistics...

& Analysis output will be saved in the same coordinate
Meighborhood Statistics.. zyztem as the input [or first razter input if there are
- multiple inputs).

Zonal Statistics..

' Analysis output will be saved in the same coordinate

Fieclassify.. system as the active data frame.

Fiaster Calculatar...

c " W Dizplay wamning message if raster inputs have to be
el 4 projected during analysis operation.

ok, I Cancel

2. Specify a working directory on your local drive in
which to place your analysis results. For example, type 3 4
c:\spatial to create a folder called spatial on your C:\
drive for use throughout this tutorial.

Click the Extent tab.

Gereral  Extent | Cell Sizel

Analysiz extent: ISame az Layer "landuse" Vl @l
Top: I 231342353

W

4. Click the Analysis extent dropdown arrow and click
Same as Layer “landuse™.

The extent of all subsequent resulting datasets will be Lt | 471030083 Righ | 494685083
the same as the Landuse layer.
Eottom: I 208342353

Shiap externt b |<N0ne> VI @l

] I Cancel |
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5. Click the Cell Size tab.

6. Click the Analysis Cell Size dropdown arrow and click
Same as Layer “elevation™.

7. Click OK on the Options dialog box.
This will set the cell size for your analysis results to be
at a 30-meter resolution (the largest cell size of your
datasets).

Examining a histogram

1. Click the Layer dropdown arrow and click landuse.

2. Click the Histogram button.

Spatial Analyst
Spatial Analyst | Layer: Ilanduse

The histogram displays the number of cells of each type
of landuse.

3. Close the Histogram.

QUICK-START TUTORIAL

Creating a hillshade

Creating a hillshade from elevation data and adding
transparency gives you a good visual impression of the
terrain and can greatly enhance the display of your map.

1. Click the Spatial Analyst dropdown arrow, point to
Surface Analysis, and click Hillshade.

Spatial Analyst

|SpatiaIAnaIyst - | Layer Ilanduse j ﬂ'ﬁ i
Distance »
Density

Interpolate to Faster »

Contour...
Cell Statistics... Slope...
Meighborhood Statistics. .. Aspect...

Hillshade...
Wiewshed..

Zonal Statistics. .

Reclazsify...

R aster Caloulator. .
Corvvert »

Optiohs...

2. Click the Input surface dropdown arrow and click
elevation. Leave the defaults for all other options.

Hillzhade [ x]
Input suface elevation - 3 —9
Azimuth: 215
Altibude: |—45
™ Modsl shadows
Z factar: |—1
Output cell size: li?-ﬂ
Dutput raster: <Temporany> EI
Cancel
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3. Click OK on the Hillshade dialog box.

The result of the Hillshade function is added to the map
as a new layer.

W

All results from analysis functions are femporary. If you
want to make any result available for future use, you
should make the dataset permanent.

4. Right-click the created hillshade layer and click Make
Permanent.

5. Navigate to the folder on your local drive where you set
up your working directory (C:\Spatial).

6. Type “Hillshade” in the Name text box.

7. Click the Save as type dropdown arrow and click ESRI
GRID.

8. Click Save.

Note: A copy of Hillshade can be found in the location
ArcGIS\ArcTutor\Spatial\Results\Ex 1\Hillshade on the
drive where the tutorial data is installed.
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= £ Layers
=) schaols

i3

= tec_sihes
*
= tnads
= Hillsh g
- W Copy
H ¥ Remove

Lt Dpen Attibute T able
E M landu Joins and Relates »

D:' @ Zoom To Layer

[18. 48 Zoom To Raster Resolution
1B
e
mF Set Data Source...

| R
= Save Az Layer File.

B eleva Make Peimanent.. —o

W
H Properties...

“isible Scale Range »

Save As

Look in: I[:] Spatial

=l =] Eslswlck [ =

Name: |H|\Ishade —0
Save as type: IESHI GRID :IJ Cancel |

o @
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Applying transparency

You will now make the Landuse layer transparent so the
Hillshade can be seen through it.

1. Click Hillshade of elevation in the table of contents and

drag the layer below the landuse layer.

I2

= £F Layers

5| schaols

&

=] rec_sites
®
=] roads

= Hillshade of elevation

Walue
High : 255

Lowe: 0
=] landuse
Landuze
[ Agriculture
[] Barren land
[ Brush/transitional
[ Built up
I Forest
i ater
[ ] Wwetlands

5] elevation
Walue
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Click View on the Main menu, point to Toolbars, and
click Effects.

Click the Layer dropdown arrow and click landuse.

4. Click the Adjust Transparency button and move the
scroll bar up to 30 percent transparency.

The Hillshade layer can now be seen underneath the
landuse layer, giving a vivid impression of the terrain.

QUICK-START TUTORIAL

m D ata View

m Layout Yievs

Zoom Data

Zoom Layout

Bookmarks

E Table OF Contents
[~s

tatus Bar

Dverflow Labels...

Identify Fesults...

E Serollbars
(%5 Fulers

l>¥- GLides
Giid

Data Frame Properties. .

|T Main tenu
|7 Standard
|T Tonls:

|7 Draw

Layout
|T Spatial Analyst

Editar

Georeferencing
Dimensioning

Data Frame Tools
Lltility Metwork. Analyst
Wersianing

Graphicz

Edit Cache
LCustamize. .

Wiew Source

landuze

Sy

Tranzparency
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Exploring your data gives you a useful basis of informa-
tion that will help you during your analysis. For ex-
ample, you need to know the different landuse types and
their distribution over an area, as well as their relative
importance, in order to decide how much weight each
should have in a suitability model. Alternatively, you
need to know how rugged the terrain is so you know to
include s/ope as a factor in determining the least-cost
path.

Having explored your data, you are now in a position to
begin to find suitable locations for the new school.

First, you will need to remove all the layers used in this
exercise.

5. Click the top layer in the table of contents to highlight
it. Press and hold the Shift key and click all other layers.

6. Right-click one of the layers in the table of contents and
click Remove.
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|%

B £ Layers

Vigble Scale Range  »
Saye fellayenkie..

0w
= P

\ Q‘ Fioperties...

High : 4361

Low : 438

All layers will be removed from the ArcMap data frame.

This exercise showed you how to display and explore your
data. In the next exercise you will use the Spatial Analyst
functions to find a potential site for a new school. You can
continue on with the tutorial or close ArcMap and continue
at a later date. There is no need to save the map document
at this point.

Note: To save your work at any time, click the File menu
and click Save As. Navigate to the location where you set
up your local working directory (C:\Spatial), specify a
filename for the map document (Spatial _Tutorial), and
click Save. Simply open Spatial Tutorial. mxd when you
wish to continue with the tutorial. You will, however, be
prompted when it is appropriate to save the map document.
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Exercise 2: Finding a site for a new school in Stowe, Vermont, USA

In this exercise you will find suitable locations for a new
school. The four steps to produce such a suitability map are

outlined below.

Derive Datasets

'

Decide which datasets you need as

Step 1: inputs. The datasets you will use in
Input Datasets this exercise are displayed to the
l right.
Step 2: Derive datasets. Create data from

existing data to gain new informa-
tion.

Step 3: Reclassify cach dataset to a common
Reclassify scale (for example, 1-10), giving

Datasets higher values to more suitable

l attributes.

Step 4: Weight datasets that should have
Weight and more influence in the suitability

Combine model if necessary, then combine

Datasets them to find the suitable locations.

Your input datasets in this exercise are Landuse, Elevation,
Recreation Sites, and Existing Schools. You will derive
slope, distance to recreation sites, and distance to existing
schools, then reclassify these derived datasets to a common
scale from 1-10. You will then weight them according to a
percentage influence and combine them to produce a map
displaying suitable locations for the new school. The
diagram to the right shows the process you will take.

QUICK-START TUTORIAL

Schools

Landuse Elevation Recreation

i

Reclassify  Reclassify

\\//

Weight and Combine Datasets

Reclassify
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Step 1: Inputting datasets

1. Click the Add Data button on the Standard toolbar.

Standard

DSE&EF B@% |0 B f2e 5
1

2. Navigate to the folder on your local drive where you
installed the tutorial data (the default installation path is
ArcGIS\ArcTutor\Spatial, on the drive where the tutorial
data is installed).

. Click elevation, then click and hold down the Ctrl key
and click landuse, rec_sites, and schools.

4. Click Add.

98]

_o

Name: [elevafion; Tanduse; rec_sies.shp: schools.shp Add

Cancel

Show of type IDalasets and Lapers (%) j

Each dataset is added to the ArcMap table of contents as
alayer.
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Setting the analysis properties

Set up the analysis options like you did in Exercise 1.

1. Click the Spatial Analyst dropdown arrow and click
Options.

2. Specify a working directory on your local drive in
which to place your analysis results. Type c:\spatial to
create a folder called spatial on your C:\ drive.

Click the Extent tab.

98]

4. Click the Analysis Extent dropdown arrow and click
Same as Layer “landuse™.

5. Click the Cell Size tab.

6. Click the Analysis Cell Size dropdown arrow and click
Same as Layer “elevation™.

7. Click OK on the Options dialog box.
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Step 2: Deriving datasets

Deriving data from your input datasets is the next step in
the suitability model. You will derive the following:

» Slope from elevation
» Distance from recreation sites

» Distance from existing schools

Deriving slope

Since the area is mountainous, you need to find areas of
relatively flat land to build on, so you will take into consid-
eration the slope of the land.

1. Click the Spatial Analyst dropdown arrow, point to
Surface Analysis, and click Slope.

Spahial Analyst
|Spatial Analyst - | Layer: Ielevation j fﬁ; i
m Distance » '
Dengity...
Interpolate ko R aster 3

Contaur...

Cell Statistics. .. Slope...

Azpect. .
Hillzhade. ..
Wiewszhed...

Meighborhood Statistics...

Zonal Statistics. .

Reclazzify...

Faster Calculatar...

Corvert »

Options....

2. Click the Input surface dropdown arrow and click
clevation.

QUICK-START TUTORIAL

3. Type slope in the Output raster text box to permanently
save your output slope dataset to the location of your
working directory (c:\spatial).

You will use this dataset again in Exercise 3.

Note: A copy of this slope dataset can be found in the
location ArcGIS\ArcTutor\Spatial\Results\Ex2\Slope.

4. Click OK.

2
Slope I
Input surface: Ielevation ﬂ El
Dutput measurement; & Degres = Percent

Z factar:

Output cell size:

Clutput raster: Islope D"'l

© o

The output slope dataset will be added to your ArcMap
session as a new layer. High values (red areas) indicate
steeper slopes.

Cancel |

25



3. Click OK.

Straight Line HE

Distance to: rec_sites -. - _9
I awirmum distance: Ii

Output cell size: I a0

[~ Create direction: |<Temporaw> 27*'
™ Create allocation: |<Temporary> 2?*'
Output raster: W EI
ok | cancel |
Deriving distance from recreation sites
In this model, it is preferable that the school be built near (3

recreational facilities, so you will now calculate the
straight-line distance from Recreation Sites.

The output distance to the rec_sites dataset will be

1. Click the Spatial Analyst dropdown arrow, point to added to your ArcMap session as a new layer. Values of
Distance, and click Straight Line. zero indicate the location of a recreation site, with

values (distances) increasing as you move away from

each of these sites.

Spatial Analyst

Spatial Analyst = | Layer: Ielevation

4 Shaight Line...
Dienaity.... Allocation. ..
Interpolate to Raster 3 Cost Weighted...

Surface Analysis 4 Shortest Path

Cell Statistics...

Meighborhood Statistics...

Zonal Statistics...

Reclassify...

Raster Calculatar..

Cornwert 3

Optians. ..

2. Click the Distance to dropdown arrow and click
rec_sites.

Leave the defaults for all other options.
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Note: A copy of this distance to rec_sites dataset can be
found in the location
ArcGIS\ArcTutor\Spatial\Results\Ex2\recD.

4. Uncheck the box next to Schools to turn off this layer so
you only see the locations of the recreation sites and the
distance to them.

Deriving distance from schools

You will now derive a dataset of distance from existing
schools. It is preferable to locate the new school away from
existing schools to spread out their locations through the
town.

1. Click the Spatial Analyst dropdown arrow, point to
Distance, and click Straight Line.

2. Click the Distance to dropdown arrow and click schools.
Leave the defaults for all other options.
. Click OK.
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Straight Line
Distance ta:
M aximum distance:
Output cell size:

™ Create direction:

Wﬂ
Wﬁ
Wﬁl

o]

©

[ Create allacation:

Olutput raster;

Cancel |

QUICK-START TUTORIAL

The output distance to schools dataset will be added to
your ArcMap session as a new layer.

4. Check the box next to the schools layer to turn it back
on and uncheck the box next to rec_sites to turn this
layer off so you only see the locations of the schools and
the distance to them.

Note: A copy of this distance to schools dataset can be
found in the location
ArcGIS\ArcTutor\Spatial\Results\Ex2\schD.
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Step 3: Reclassifying datasets

You now have the required datasets to find the best location
for the new school. The next step is to combine them to
find out where the potential locations can be found.

In order to combine the datasets, they must first be set to a
common scale. That common scale is how suitable a
particular location (each cell) is for building a new school.
You will reclassify each dataset to a common scale, within
the range 1-10, giving higher values to attributes within
cach dataset that are more suitable for locating the school:

* Reclassify slope
* Reclassify Distance to recreation sites
* Reclassify Distance to schools

* Reclassify landuse

Reclassifying slope

It is preferable that the new school site be located on
relatively flat ground. You will reclassify the Slope layer,
giving a value of 10 to the most suitable slopes (those with
the lowest angle of slope) and 1 to the least suitable slopes
(those with the steepest angle of slope).

1. Click the Spatial Analyst dropdown arrow and click
Reclassify.

2. Click the Input raster dropdown arrow and click Slope.
3. Click Classify.
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Spatial Analyst

Spatial &nalist ¥ | Layer: |e|evalion T B
_ Distance »
Drenazity..
Interpalate to Raster 3
Surface Analysiz 3
Cell Statistics

Meighborhood Statistics

Zonal Statistics...

—OQ

Raster Calculator

Canwert »

Optionz...

2
Reclassify
Input raster: IS\ope j #l
Reclass field: IVaIue j
— Set values ta reclassify
Old valugs | Mew values - Clazszify.... e
0.000000 - 7.711152 1 ;
FEARR LR i 3 Unique |
15422304 - 23133456 3
273133456 - 30844608 4 Add Enfry
30844608 - 38585759 5 - —I
o - | » Delete Entriasl
Load... | Save.. |
[~ Change missing valuss to NoData
Output raster: |<Tempolary> EI
0k I Cancel |
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Interval.

5. Click the Classes dropdown arrow and click 10.

6. Click OK.

. Click the Method dropdown arrow and click Equal

: |
Matted [ ogud iein =] IFIvET]
| m = :rmun a
it
Lo [Tie!
Bl vy vt e
Cohamns ||m§
EH ] E E § B ﬁ
1500 = & i
ﬁ B B ¥ & & & 8 §
~ ¥ @8 & ® % # g =g =g
10000
00
ol T T .
(] 10712638 IDAIEITIT  SONITGIEE  TREEDSGAL

T¥ Sna e I dox yhlaey

ey

7
Input raster: [stope | El
Reclass fisld: [value =
Set values tn reclsss
Ol values NEw valus — 4] Classiy
FF1113183 - 154723028 190 ']_ ricue_ |
B S TR Y
ST S SRS Z e Eniry

30.8446075 - 355557534

4

| > Dekete Enties |

Load.. Save...

™ Change missing values to NoData

Dlutput raster. |<Temporary>

=
o q] oo |

(8]

The output reclassified slope dataset will be added to your

You want to reclassify the Slope layer so steep slopes
are given low values, as these are least suitable for
building on.

7. Click the first New value record in the Reclassify dialog
box and change it to a value of 10. Give a value of 9 to
the next New value, 8 to the next, and so on. Leave
NoData as NoData.

8. Click OK.

QUICK-START TUTORIAL

ArcMap session as a new layer. Locations with higher
values (less-steep slopes) are more suitable than locations

with lower values (steeper slopes).
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Note: A copy of this reclassified slope dataset can be found
in the location
ArcGIS\ArcTutor\Spatial\Results\Ex2\slopeR.

Reclassifying distance to recreation sites

The school should be located near recreational facilities.
You will reclassify this dataset, giving a value of 10 to
areas closest to recreation sites (the most suitable loca-
tions), giving a value of 1 to areas far from recreation sites
(the least suitable locations), and ranking the values in
between. By doing this you will find out which areas are
near and which areas are far from recreation sites.

1. Click the Spatial Analyst dropdown arrow and click
Reclassify.

Spal st
‘Spal\alAna\ySl - | Layer: Ielevation j @ I
m Distance »
Density...
Interpolate to Raster 3
Surface Analysis 13
Cell Statistics...

Meighborhood Statistics...

Zonal Statistics...

Raster Calculatar...

Canvert »

Options..

2. Click the Input raster dropdown arrow and click Dis-
tance to rec_sites.

3. Click Classify.

30

|nput raster;

[Distance to rec_sites R =2

Rieclass fiskd [Fvaie =

Set values to reclassil

0ld walues ‘ MNew values - Classify... e

0.000000 - 1348, 762793 1

1348 7R 9E - 2697 5haEE 2 Urique |
S BERRGE T AAE T

FlFCheer et i Add Eniry
455 T VS BT ET35EE S —I

1)
Load... Save. I

™ Changs missing valuss to Mol ata

=
| » Delste Enlnasl

Output raster |<Tampmary> =
_DK Cancel

4. Click the Method dropdown arrow and click Equal
Interval.

5. Click the Classes dropdown arrow and click 10.
6. Click OK.

(4]

21X
rC | Classifisation
Method:  [EqualInterv. =l Count: G2862
i Mirimure: 0
e I Masimum 13382, 2558
Data Enchusion Sum 2585633020
Hean 42895714
7| Use Custom il e e Exclusion ... Standard Deviation 2655, 88061
I= | Gelovscustarm it
& Sampl
e e b Edyarced Bteiies
Cotumns: 100 = T ShowStd Dev. [ Showean Breskvaus: %
g = ©® B ® 8 3 & B =& 133822550
woone B 0F & 0§ 8 & 0§ 8 F 267645117
@ © - o = = e = 4 2
100004
5000
|
334556306 689112792 10036E1G 133823558
I Srizp breske to data values I} Log Flat Cancel
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You want to locate the school near recreational facili-
ties, so you will give higher values to locations close to
recreational facilities, as these are the most desirable.

7. As you did when reclassifying the Slope layer, click the
first New value record in the dialog box and change it to
a value of 10. Give a value of 9 to the next New value, 8
to the next, and so on. Leave NoData as NoData.

8. Click OK.

7
Reclassify HE
Input raster. IDistanca ta rec_sgtes j Bql
Reclass figld: IVaIue j
— Set values ta reclassify
0ld values | Mew valles - Clazzify.. |
.. ) :

1348 76279 - 269752559 4 | Uniguz |

29752009 - 4046.28538 8

AD04E. 28838 - 539505117 7 #dd Entry

539505117 - 67438139 & - —I

o T | _pl_l Delete Entriesl

Load.. | Save.. |

™ Change missing values to MoData

|<Temporary> EI
ok I Cancel |

Output raster.

QUICK-START TUTORIAL

The output reclassified distance to recreation sites
dataset will be added to your ArcMap session as a new
layer. It shows locations that are more suitable for
locating another school. High values indicate more
suitable locations.

Note: A copy of this reclassified distance from recreation
sites dataset can be found in the location
ArcGIS\ArcTutor\Spatial\Results\Ex2\recR.
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Reclassifying distance to schools

It is necessary to locate the new school away from existing
schools in order to avoid encroaching on their catchment
areas. You will reclassify the Distance to schools layer,
giving a value of 10 to areas away from existing schools
(the most suitable locations), giving a value of 1 to areas
near existing schools (least suitable locations), and ranking
the values in between. By doing this you will find out
which areas are near and which areas are far from existing

schools.

1. Click the Spatial Analyst dropdown arrow and click

Reclassify.

Spat st

‘Spal\alAna\ySl - | Layer: Ielevation
Distance »
Denzity....
Interpolate to Raster 13
Surface Analysis 3
Cell Statistics...

Meighborhood Statistics...

Zonal Statistics...

Raster Calculatar...

Convert »

DOptions:

2. Click the Input raster dropdown arrow and click Dis-

tance to schools.
3. Click Classify.
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Reclassify [x]
Input raster ID\stance to schools | EI
Risclass field: [vaue =l

Set values to reclassif
0ld values | Mew values - Classify. e
000000 - 1692 788548 T
16592 709046 - Jad5.879207 2 | Wit |
s et L e
5178 368945 - 771 158584 4 Add Enty
6771 158554 - §4E3 5485425 = —I
o | » Delete Entliesl
Load Save
I™ Change missing values to NoData
Olutput raster I<Tempurary> EI

4. Click the Method dropdown arrow and click Equal

Interval.

5. Click the Classes dropdown arrow and click 10.

6. Click OK.
Clazadicaton Olati
Mathod  [Fgud iedm =] 7
Claster |10 = iy
- Dad B
r Eychren I
e
. Samging |
Comne 100 5 [ ‘ShowSid Dev. [ Showblaz
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ys000r & ’: % ? g .;.‘I &
gl g = g 8 g
g B B i B 2
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You want to locate the school away from existing
schools, so you will give higher values to locations
farther away, as these locations are most desirable.

As the default gives high New values (more suitable) to
high Old values (locations farther away from existing
schools), you do not need to change any values this
time.

. Click OK.

Reclassify HE
Input raster: ID\stancE to schools ﬂ @l
Reclass field: IVaIue j
 Set values to reclassif

0ld valuss [ New values - | “Clagsih
0 - 1E32. 72965 1 =
169276965 - 33985 5793 2 | Urigue
338E.5793-BO7E36835 3
5078 36095 - 6771150594 fdd Enry
E771.15800 - 246354824 B = —I
ﬂ{‘r e o o | » Delete Entriesl
Load. Save..
™ Change missing values to NoDiata
Output raster, I<Tempﬂrary> @l
ak J Cancel |

The output reclassified distance to schools dataset will
be added to your ArcMap session as a new layer. It
shows locations that are more suitable for locating
another school. Higher values indicate more suitable
locations.

QUICK-START TUTORIAL

Note: A copy of this reclassified distance from schools
dataset can be found in the location
ArcGIS\ArcTutor\Spatial\Results\Ex2\schR.
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Reclassifying landuse

At a town planners meeting it was decided that certain
landuse types were better for building on than others,
taking into consideration the costs involved in building on
different landuse types.

You will now reclassify Landuse. A lower value indicates
that a particular landuse type is less suitable for building
on. Water and Wetlands will be given NoData as they
cannot be built on and should be excluded.

1. Click the Spatial Analyst dropdown arrow and click
Reclassify.

Spatial Analpst

Spatial Analyst * | Layer: |e\evalinn d {P:ﬁ I
Distance 3
Density.
Interpolate to Faster »
Surface Analysis »
Cell Statistic:s..

Meighborhood Statistics. .

Zonal Statistics...

—

Raster Calculator. .

Corwvert »

Options..

2. Click the Input raster dropdown arrow and click
Landuse.

W

. Click the Reclass field dropdown arrow and click

Landuse.
4. Type the following values in the New values column:
Agriculture—10 Built up—3
Barren land—6 Forest—4

Brush/Transitional—5

34

You will now remove the Water and Wetland attributes
and change their values to NoData.

5. Click the row for Water, press the Shift key, click
Wetlands, then click Delete Entries.

6. Check Change missing values to NoData.

All values for Water and Wetlands will be changed to
NoData.

7. Click OK.

il ks

|put raster: IIandusa j EI
Reclass field: ILanduse —ﬂ'——e

— Set valugs to reclassit

Old values | ew values | [Elassifi.. |
Agriculure 10
Earren land 3 g |
Erush/tranzitional 5
Buil up 3 4dd Entry |
Forest 4
HoD ata HoData Delete Entries 6

Load... | Save.. |

v Change mizssing values to NoDats

tpuk raster: |<Tempo|ary> i’*l

0k I Cancel |

o @
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The output reclassified landuse dataset will be added to
your ArcMap session as a new layer. It shows locations
that have landuse types that are considered to be better
than others for locating the school (higher values
indicate more suitable locations).

8. Right-click Reclass of landuse in the table of contents
and click Properties.

9. Click the Symbology tab.

10. Click the Display NoData as dropdown arrow and click
Arctic White to show NoData values (Water and
Wetlands) in this color.

11. Click OK.

QUICK-START TUTORIAL

Layer Properties

Genalal' Sourca' Extemll Display  Syrmbalogy | Fields |
Shaow:

W ‘ Draw raster assigning a color to each value

Classified

Stretched ~Walue Field Color & cher
P = [I Imml I -
[ Symbol [ <aLUE> [ Label [Comnt [
I <=l cther valuzss <all ather values:>

<Heading> YALUE

o 3 25054
. ¢ 4 ABEE1E
I - 5 205
[ s E 21
[ T 10 59224

Add 4l Y alues | AddYalues. | HEmuveVaIuesI Default Colors |

Dizplay NoDrata as

o]
(11] (10]

Note: A copy of this reclassified landuse dataset can be
found in the location
ArcGIS\ArcTutor\Spatial\Results\Ex2\landuseR.

Cancel | Apply |
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Step 4: Weighting and combining datasets

After applying a common scale to your datasets, where
higher values are given to those attributes that are consid-
ered more suitable within each dataset, you are ready to
combine them to find the most suitable locations.

If all datasets were equally important, you could simply
combine them at this point; however, you have been
informed that it is preferable to locate the new school close
to recreational facilities and away from other schools. You
will weight all the datasets, giving each a percentage
influence. The higher the percentage, the more influence a
particular dataset will have in the suitability model.

You will give the layers the following percent influence:

(Each percentage is divided by 100 to normalize the
values.)

Reclass of Distance to rec_sites: 0.5 (50%)
(25%)
0.125  (12.5%)
0.125 (12.5%)

1. Click the Spatial Analyst dropdown arrow and click
Raster Calculator.

Reclass of Distance to schools: 0.25
Reclass of landuse:

Reclass of slope:

36

Spatial Analyst

Spatial &nalpst | Layer Ielevation =l B
m Digtance »
Density...
Interpolate to B aster 13
Surface Analysis 3
Cell Statistics. ..

Neighborhood Statistics...

Zonal Statigtics...

Reclassify...

Raster Calculator...

—0

Corrvert »

Options..

2. Double-click Reclass of Distance to rec_sites from the
Layers list to add it to the expression box.

Click Multiply.

Click 0.5.

Click Add.

Double-click Reclass of Distance to schools.
Click Multiply.

Click 0.25.

Click Add.

10. Double-click Reclass of landuse.
11. Click Multiply.

12. Click 0.125.

13. Click Add.

14. Double-click Reclass of slope.
15. Click Multiply.

A e A
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16. Click 0.125. 18. Right-click the newly created raster layer in the table of

17. Click Evaluate to perform the weighting and combining contents and click Properties.
of the datasets. 19. Click the Symbology tab.
20. Click Classified from the Show list.

21. Click the Classes dropdown arrow and click 10.

_*l _?l _al _Sl _=| il El 22. Scroll to the last three classes, click one, then press and

Raster Calculator EHE

Layers

Diztance torec_sites |«
Digtance to schools

slevation | ;l _4| _5| _Bl ;l i| i| hold the Shift key and click the other two.
Reciass of Ditance b 23. Right-click the highlighted classes, click Properties for
I e ck a br
e il selected Colors, and click a bright color.
—"J _+| 4D| _l Ll _]l El 24. Click the Display NoData as dropdown arrow and click
[Reclass of Distance to rec_sites] * 0.5 + [Reclass of Distance to schaoalg] = ;I the COIOI black. ThlS displays Values ofNoData (Water

0.25 + [Reclass of landuse] * 0125 + [Reclass of Slope] * 0,125 . .
and Wetlands) in this color.

25. Click OK.

Evaluate I LCancel |LI
(17)

\ Draw raster grouping values into classes

Field: Classification
. Yalue: lh[ Equal frterval
The output raster dataset shows you how suitable each { Komdeston [vones ] L Mo =] | [ckesins
location is for locating the new school, according to the s [ |
criteria you set in the suitability model. Higher values Sy (R [ —

[ PRES 444975
I 4575555 4975 -5.55

5.55-6.125 5.55-6.128

indicate locations that are more suitable.

6.125-67
6.7

The suitable locations are those areas that are close to

recreation sites, away from existing schools, on rela- T A ; :I
tively flat land, and on certain types of landuse. The I~ o M EEEE Disply NeDsa s -\-I--—@
higher weightings set for Distance to schools and RoveraSairg EnEE
Distance to rec_sites have a powerful influence on ol

Edit Description

deciding which areas are more suitable than others.

® D

QUICK-START TUTORIAL 37



You decide that there are three main potential areas for
locating the school. They are labeled in the diagram
below.

Area 1

Area 3

You should now assess these locations to see which
might be the best location. This should be done in the
field, as well as by examining the data you have on each
potential area.

26. Right-click the output layer in the table of contents and
click Make Permanent.

27. Navigate to the folder on your local drive where you set
up your working directory (c:\spatial).

28. Type Suitability and click Save.

The temporarily created dataset will now be perma-
nently stored on disk.

38

Note: A copy of this Suitability dataset can be found in
the location
ArcGIS\ArcTutor\Spatial\Results\Ex2\Suitability.

29. Click the output raster twice slowly. Rename the layer
Suitability.

= 0 roads

Walug
W 325-3.825
82544
W 44-4975
I 45975 - 555

= [

You decide that the best location is somewhere within

Area 1, as there are three recreation sites in the neighboring
area, the ski resort being one of them. Also, although you
know that a considerable volume of traffic already uses the
current access road to this potential site, you are involved
in plans for constructing an alternative road to this area,
which will help alleviate the volume of traffic on the
current access road.

30. Click the Schools layer in the table of contents, press
the Ctrl key, and click all other layers except Suitability
(use the scroll bar to move down the table of contents).

31. Right-click one of the highlighted layers and click
Remove.

You have now completed Exercise 2. You can continue on
to Exercise 3, or you can stop and continue later. Which-
ever option you choose, save the map document at this
point. Click the File menu and click Save As. Navigate to
the location where you set up your local working directory
(c:\spatial), specify a filename for the map document
(Spatial_Tutorial), and click Save.
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Exercise 3: Finding an alternative access road to the new school site

In this exercise you will find the best route for a new
access road. The steps you might follow to produce such a
path are outlined below, and the steps you will take in this
exercise are diagrammed to the right.

Step 1: Create Source and Cost Datasets

Create the source dataset if necessary. The Source is the
school site in this exercise.

Create the cost dataset by deciding which datasets are
required, reclassifying them to a common scale, weighting,
then combining them.

Step 2: Perform Cost Weighted Distance

Perform cost weighted distance using the Source and Cost
datasets as inputs. The Distance dataset created from this
function is a raster where the value of each cell is the
accumulated cost of traveling from each cell back to the
source.

To find the shortest path, you need a Direction dataset,
which can be created as an additional dataset from the cost
weighted function. This gives you a raster of the direction
of the least costly path from each cell back to the source (in
this exercise, the school site).

Step 3: Perform Shortest Path

Create the destination dataset if necessary. In this exercise,
the Destination is a point at a road junction.

Perform shortest path using the Distance and Direction
datasets created from the cost weighted function.

QUICK-START TUTORIAL

Step 1: Create Source and Cost Datasets

Source

P

Step 2: Cost Weighted Distance

Destination

Distance Direction

Step 3: Shortest Path

39



Step 1: Creating the source and cost datasets

To find the best route to the potential school site, you will
first need to create the Source dataset (the school site) from
the suitability map, and a Cost dataset, and use these as
inputs into the cost weighted function.

Creating the source dataset

If you want to know how to create the Source dataset,
follow the next 29 steps. Alternatively, click the Add Data
button and navigate to the location where you installed the
tutorial data (ArcGIS\ArcTutor\Spatial). Click Roads, then
click Add. Then, click the Add Data button again and
navigate to ArcGIS\ArcTutor\Spatial\Results\Ex3. Click
School site, then click Add and skip the next 29 steps.

You will first create an empty shapefile in ArcCatalog, then
digitize the location of the site using the editing tools in
ArcMap.

1. Click the ArcCatalog button on the Standard toolbar.

DEEH& % B@d%|a | $|[Hosm =l 2| &2

2. Navigate in the Catalog tree to the folder on your local
drive where you set up your working directory
(c:\spatial).

. Right-click the Spatial folder, point to New, and click
Shapefile.

W
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F-g SC51
=R Copy  Ciki
B pasre Coliid
¥ Delete
Fename

Befresh

Eolder

Fersonal Geodatabase

€ Search
Properties... Layer...
I m Group Layer

4. Type “School_site” for the name of the new shapefile.

5. Click the Feature Type dropdown arrow and click
Polygon to choose the type of feature that will be
created.

6. Click Edit to add spatial reference information to the
shapefile.

Cieate New Shapefile

Name: |5cth site

Feature Type: [Palvgon =l

I~ Spatial Reference

Desciiption,

Unknown Coordinate System =

.
1 ¥
W Edt.. G

™ Coordinates will contain M values. Used to stors 30 data.
™ Coordinates will containZ valugs. Used to store raute data.

Cancel
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7. Click Select to use a predefined coordinate system.

Sipatial Heloioncs Propeilies

Continate System |

[ T

Detais:
L]
L]

0__ Selset mbect o prmdalrnd coucate e
Impait & coowdinete syatem and WY, T and M
oot domar fom s evitheg pecdatanet feg,
inatuan dalnsed, Insnan claes, antes)
N +| Crewe
[ Edt the properties of the cumently selacted
___I coordnate wyitem.
| Getethe coondnse sptem s Unbcum
_I Sarvn e comidnale sysbem 1o & be

R = |

8. Click the Projected Coordinate Systems folder, click
State Plane, then click NAD 1983 and scroll to NAD
1983 StatePlane Vermont FIPS 4400.prj.

9. Click Add.

Lookire [ Hap 1983 =1
TNAD 1983 StatePlare Wi
A MAD 1563 StatePlane Wiss
I NAD 1583 StatePlane W
AENAD 1903 StatePlane Wi
T NAD 1563 StateFlane W
4B NAD 1963 StatePlane Wi

(I NAD 1983 StatePlane Utah South FIPS M203.pi
MA| ‘ermont FIPS 4400 prj

T MAD 1983 StatePlane Viginia Morth FIPS 4501, pij

|5 MAD 1983 StatePlane Viginia South FIPS 4502 pr

| MAD 1983 StateFlane Washington Morth FIFS 4601 pij

@NAD 1963 StatePlane W ashington South FIPS 4602 prj

T MAD 1983 StateFlane West Viiginia North FIFS 4701 pi

@NAD 1963 StatePlane West Virginia South FIPS 4702.pr

| MAD 1983 StateFlane Wisconsin Cential FIFS 4802 pij

[ (E
Marme: [HAD 1983 StatePlane Vemont FIPS 4400 pr —0
Shaow of type: |Spaua\ references =l Cancel
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10. Click OK on the Spatial Reference Properties dialog

I1.

12.

14.

15

16.

17.
18.

box.
Click OK on the Create New Shapefile dialog box.

A new shapefile called School_site will be created and
added to the Catalog tree.

Click File, click Exit to close ArcCatalog, and return to
ArcMap.

. Click the Add Data button and navigate to the folder on

your local drive where you installed the tutorial data
(the default installation path is
ArcGIS\ArcTutor\Spatial).

Click roads.shp.

. Click Add.

1% schools shp

Mame: |loads shp Add _@
Show of type: [ Datasels and Layers [“.ly] =l Caricel

Click the Add Data button again and navigate to the
folder on your local drive where you set up your
working directory (c:\spatial).

Click School_site.
Click Add.
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19. Click the Zoom In tool on the Tools toolbar and zoom
in on the area that was deemed most suitable (area 1,
circled in yellow below).

e EE
AE wd

A
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20. Click View, point to Toolbars, and click Editor.

Main Menu

File Edit | View Inzert Selection Tools “window Help

m Diata View

m Lapaut iew

Zoom Data

Zoom Lapout

Eookmarks

v v v

4 |7 Main Menu

E Table Of Contents |7 Standard

|T Statuz Bar Toolz
Dverflow Labels.. ’7 Drraw
Identify Results Laypout

ﬁ Scrollbars [v  Spatial Analyst

5 Fulers |T Effects

D'Y- [udes

Grid Georeferencing

Dimensianing

D ata Frame Properties...
Drata Frame Tools

Lltility Metwark Analyst
“Wersioning

Graphicz

Edit Cache
LCustamize...

iew Source

21. Click the Editor dropdown arrow and click Start
Editing.

Editar ~ | [ 3 |, - | Tjask ICreate Mew

Start Editing

Stop Editing
Save Edits

=L B id Edib Bache

[ i

fove..
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22. Click c:\spatial (or wherever you specified your work-
ing directory to be) for the folder from which to edit
data.

23. Click OK.

24. Click the Task dropdown arrow and click Create New
Feature.

25. Click the Target dropdown arrow and click School_site.

26. Click the Create New Feature dropdown arrow and
click Create New Feature.

Edtor v | & |

- | Task: |Ereale News Feature
L

j | Target: |SchooLsitE |;| ‘

2

{{ Create Mew Feature

27. Draw a polygon on the screen in the location shown in
the diagram. Click and hold to add a polygon vertex,
drag the cursor, and add another polygon vertex.
Continue until the polygon is complete. Double-click to
close the polygon.

QUICK-START TUTORIAL

28. Click the Editor dropdown arrow and click Stop Edit-
ing.
29. Click Yes to save your edits.

Note: A copy of this school_site dataset can be found in the
location ArcGIS\ArcTutor\Spatial\Results\Ex3\source.shp.

Creating the cost dataset

You will now create a dataset of the cost of traveling over
the landscape, based on the fact that it is more costly to
traverse steep slopes and construct a road on certain
landuse types.

1. Right-click the Suitability layer and click Remove.

2. Click the Add Data button and navigate to the folder on
your local drive where you set up your working direc-
tory (c:\spatial).

3. Click slope (the dataset created in exercise 2).

4. Click Add.

5. Click the Add Data button again and navigate to the
folder on your local drive where you installed the
tutorial data (the default installation path is
ArcGIS\ArcTutor\Spatial).

6. Click Landuse and click Add.
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7. Right-click Landuse and click Zoom To Layer. 2. Click the Input raster dropdown arrow and click slope.
" 3. Click Classity.

F £ Layers
= School_site
O
= roads 2
B
Copy
E X Remove
I: - | b it - =
1 E] Dpen Attribule Table MU IEEIED [spe = EI
E Joins and Pelates v Feclass field [value =l
-@ Set valuss to reclassit
4 i@ Zoom Ta Baster Resolution Ol values | New values 2| Classity e
Visible Soale Fianga » i G - 1 244354 i =
e 0544354 - f dgEReS i Uriqee_|
I o Hata 2auee. i ARG TR E
Save As Layer File.. 0.732973-0.977297 4 Add Enlry
S 6577257 -1 21878 g = —I
Erm— T B | Delete Entizs |
Load Save |
Reclassifying slope

™ Change missing values to NoData

1. Click the Spatial Analyst dropdown arrow and click Dutpul st [{Tempoary>
Reclassify. =

I

4. Click the Method dropdown arrow and click Equal

Spatial Analyst * | Laper: IlanduSB j yﬁ i Intel'val
Distance 3
Densiy.. 5. Click the Classes dropdown arrow and click 10.
Interpalate to R aster »
Surface Analpsis » 6. Click OK.
Cell Statistics...

Meighborhood Statistics...

Zonal Statistics. .

= O

Raster Calculatar...

Corvert »

Options...
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You want to avoid steep slopes when constructing the
road, so steep slopes should be given higher values in
the Cost dataset.

As the defaults give high values to steeper slopes, you
do not need to change the default New Values.

7. Click OK on the Reclassify dialog box.

The Reclass of slope layer will be added to the table of
contents. It shows locations that are more costly than
others for constructing a road (higher values indicate the
more costly areas that should be avoided).

QUICK-START TUTORIAL

Reclassifying landuse

1. Click the Spatial Analyst dropdown arrow and click

Reclassify.
S b
‘Spatial Analyst = | Layer |Ianduse
Distance 4
Density...
Interpolate to Raster »

Surface Analysis

Cell Statigtics..
Meighborhood Statistics

Zonal Statistics...

Raster Calculator...

Convert »

Options
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2. Click the Input raster dropdown arrow and click
Landuse.
3 Click the Reclass field dropdown arrow and click
Landuse.
4. Click the first New value to edit the values and type in
the following values:
Agriculture—4 Built up—9
Barren land—6 Forest—38
Brush/Transitional—5 Water—10
Higher values indicate higher road-construction costs.
5. Click Wetlands, and click Delete Entries.
6. Click Change missing values to NoData.
7. Click OK.
Input raster: I\anduse j EI
Reclass field: ILanduse —g——e
i~ Set values to reclassify
Old values |NE walues - [ElEzsifi |
e : unive_ |
Brltlshf’transitional [ |
E:,I:SL:D : . Add Entry |
l| b | _}I_I Delete Entries e
Load... | Save... |
W Change missing vwalues to MoData
utput raster: I(Tempnral_u> EI
QK I Cancel |
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The Reclass of landuse layer will be added to the table of
contents. It shows locations that are more costly than others
for constructing a road, based on the type of landuse.

The NoData value (Wetlands) is currently displayed
transparently so you can see the layers underneath. To
make this value solid, change it to white.

8. Right-click Reclass of landuse and click Properties.
9. Click the Symbology tab.

10. Click the Display NoData as dropdown arrow and click
Arctic White.

11. Click OK.

General | Soucs | Extent | Display  Symbology | Fisids |

Show:

Unigue Yalues
Classified
Stretched

| Diaw raster assigning a color to each value

‘alue Field | "Eolur henn
|Va\ue [ Mo Colar _]'

\
[ Symbol | cv/aLlE> 000000000000,
| EEOOQD0ONEE
[ s e mmm
. ONEECDEEE NN N,
B 5 EEEEEEEEEEE NS
- EEEEEEEEEEEN)
%g NESO0O00EE BB
EENCO0OO0ENER
™" EEEECOCDE N NETS
i EEEEEEEEEENE
b ] adlly ﬂ b plakes | addiah More Colors.. lault Colors
&
Ll

Display NoData as E| @

0K | Cancel | Apply I
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Combining datasets

You will now combine Reclass of slope and Reclass of
landuse in order to produce a dataset of the cost of building
a road at each location in the landscape, in terms of steep-
ness of slope and landuse type. In this model, each dataset
has equal weighting, so it is not necessary to apply any
weight as we did when finding the suitable location for the
school.

1. Click the Spatial Analyst dropdown arrow and click
Raster Calculator.

2. Double-click Reclass of landuse to add it to the expres-
sion box.

3. Click the Add button.

4. Double-click Reclass of slope to add it to the expression
box.

5. Click Evaluate.

QUICK-START TUTORIAL

Spatial Analyst + | Layer: IHaclass of landuse j 3/2 i

Distance
Dienaity. .
Interpalate to R aster

Surface Analysiz

»

Cell Statistics...

Meighborhood Statistics. .

Zonal Statistics..

Reclassify..

Convert

Options...

_|_|_|4|_|_|_|E|

o] e] o] o]
o] o)
e o e

[Reclass of landuse] + [Feclazs: of slope]

[
Ewaluate I LCancel |i|
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The result is added to your ArcMap session. Locations
with low values identify the areas that will be the least
costly to build a road through. They are displayed in
dark blue in the graphic below.

6. Click the output layer in the table of contents to high-
light it, click again, and rename it Cost.

You will now remove all layers except Cost,
School_site, and Roads.

7. Click Reclass of landuse, press and hold down the Ctrl
key, click Reclass of slope, slope, and landuse.

8. Right-click one of the layers and click Remove.
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Step 2: Performing cost weighted distance

You will now perform cost weighted distance using the
Cost dataset you just created and the School_site layer (the
source). Using this function, you will create a Distance
dataset where each cell contains a value representing the
accumulated least cost of traveling from that cell to the
school site, and a Direction dataset that gives the direction
of the least-cost path from each cell back to the source.
This conceptual process is explained in more detail in
Chapter 7, ‘Performing spatial analysis’.

1. Click the Spatial Analyst dropdown arrow, point to
Distance, and click Cost Weighted.

Staight Line...

Density... Allaeation...
Interpolate to Raster 3

Surface Analysiz »

Cell Statistics...

Meighborhood Statistics...

Zonal Statistics...

Reclassify...

Raster Calculatar..

Cornwert 3

Optians. ..
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2. Click the Distance to dropdown arrow and click
School site.

. Click the Cost raster dropdown arrow and click Cost.
. Check Create direction.
. Click OK.

W = W

Oistance ta:

Qost raster: Cost - -ﬂ__e
aximum distance: I
Output cell size: I 30

: [Temporans EI
™ Create allocation: IW ﬁl
Output raster. IW EI

Ok I Cancel |

(5]

The Distance and Direction datasets are added to your
ArcMap session as layers.

6. Click the output Distance layer in the table of contents,
click again, and rename it Distance.

7. Click the output Direction layer in the table of contents,

click again, and rename it Direction.

QUICK-START TUTORIAL

1%

= £ Layers
= roads
= School_site
[}

5] Distance G
<WALUE:

[0 - 23,804.6063
[ 23.804.6063 - 47.609.2125
[ 47 B09.2125 - F1.413.8188
I 71.413.6188 - 95.218.425
I 595.218.425 - 119.023.031
I 119.023.031 - 142.827 638
I 142,827 638 - 166.632.244
I 166,632,244 - 1590, 436.85
I 130.436.85 - 214.241.456
I 214241456 - 233.046.063

5] Direction 0

WALLE

[ Source [0]
[ Right (1]
I Lower-Right (2]

Step 3: Performing shortest path

You are now almost ready to find the shortest path from the
school site. You have performed cost weighted distance,
creating a Distance dataset and a Direction dataset, using
the school site as the source. However, you will need to
decide on, and then create, the destination point for the
road. As you have already learned how to create a new
shapefile, this destination point shapefile has been created
for you.

1. Click the Add Data button.

2. Navigate to the folder on your local drive where you
installed the tutorial data (the default installation path is
ArcGIS\ArcTutor\Spatial).

Click Destination and click Add.

Locating the destination point for the road in the posi-
tion identified by the Destination shapefile will take
much of the traffic away from the current road and
provide a “back route” to the area for school buses and
other vehicles.

98]
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4. Click the Spatial Analyst dropdown arrow, point to
Distance, and click Shortest Path.

|SpatiaIAnaIyst' | Layer ICost

Spa t

Diensity. .

Interpalate to Baster
Surface Analysis
Cell Statistics...

Meighborhood Statistics..

Zonal Statistics
Reclassify.

Raster Calculator...
Corevert

Options..

4 Straight Line. ..

Allocation
> Cost 'weighted...

5. Click the Path to dropdown arrow and click Destination.
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Click the Cost distance raster dropdown arrow and click

Distance.

Click the Cost direction raster dropdown arrow and
click Direction.

Leave the defaults for the other options.

. Click OK.

Shortest Path

Path ta:

Cost distance raster:
Cost direction raster:
Fath type:

Clutput features:

I Destination

I Distance

I Direction

| For Each Cel

Ic:\spatial\path‘l .zhp

o]

= =
o
=
5
=

Cancel |

&0

The shortest path is calculated, and the resulting layer is
added to your ArcMap session. It represents the least-
cost path (least cost meaning avoiding steep slopes and
on landuse types considered to be least costly for
constructing the road) from the school site to the road
junction.

9. Click Distance in the table of contents, press the Ctrl
key, and click Direction and Cost.

10. Right-click Cost and click Remove to remove all three
layers.

- =] Distance

AALUE:
[10- 23,804 6063
[ 23.804.6063 - 47 B09.2125
[ 47.609.2125 - 71.413.8188
I 71.413.8188 - 95,218,425
I 55.215.425 - 119,023.031
I 119,023,031 - 142,827 538
I 142,827 638 - 166,632 244
I 166,632,244 - 190.436.85
I 19043685 - 214,241 456
214,241 456 - 238,045,063

: Copy
Wl =
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Displaying the results

To see exactly where this path should be constructed, you
will now create a more detailed map.

Adding the datasets

1.
2.

Click the Add Data button on the Standard toolbar.

Navigate to the folder on your local drive where you set
up your working directory (c:\spatial).

. Click Hillshade and click Add.

Note: A copy of this hillshade dataset can be found in
the location
ArcGIS\ArcTutor\Spatial\Results\Ex 1\Hillshade.

. Click the Add Data button on the Standard toolbar.

5. Navigate to the folder on your local drive where you

6.

installed the tutorial data (the default installation path is
ArcGIS\ArcTutor\Spatial).

Click Landuse and click Add.

Applying transparency

7.

If the Effects toolbar is not already present, click View
on the Main menu, point to Toolbars, and click Effects.

. Click the Layer dropdown arrow on the Effects toolbar

and click landuse.

. Click the Adjust Transparency button and move the

scroll bar up to a transparency of 30 percent.

QUICK-START TUTORIAL

2
:'J B 2|

Transparency

Layer |landuse
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Changing the default field for Landuse

You will now change the value field for the Landuse layer
so you can more ¢asily distinguish each landuse type.

L.

Right-click Landuse in the table of contents and click
Properties.

Click the Symbology tab.

3. Click the Value Field dropdown arrow and click

landuse.

. Click OK.

Change the color of the symbols in the table of contents
to more appropriate colors for each type of landuse.

. Right-click the symbols representing landuse types in

the table of contents and pick an appropriate color for
cach one.

= lgnduse
Landuze
C [ Mo Color ]
EDDDDDDDDDDDD
gl EO000O00OEmm
e
CEHENEEDEEE NN
EEEEEEEEEEEN
EN000COCEEED
ITEEEEEECT T
EEENCCCCDEEENE
EEEEEEEEEEEN
tare Colars...
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Zooming in on the area

1. Click the Zoom In tool on the Tools toolbar.

a0

A mm
EILA ]

@
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O

@ 7

2. Click and drag a rectangle around the location of the
new road to zoom in on this area (the area to zoom to is
highlighted in red on the map below).
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Label Features

Method: Label allthe features the same way. -

Al features will be labeled using the options specified,

Text Sting
’VLahe\ Field: [STREET_NaM =] Espression. ‘
 Tent Syrbol
AaBloyEz Symbol...
- Other Optiorr Pre-defined Label Style
Label Placement Options... | Seale Aange... | ’V Label St |

oK I Cancel Apply

Label the road network to be able to identify which exist- ©
ing roads may be of use in constructing the new road. The road names are labeled on the map.

1. Right-click Roads in the table of contents and click
Properties.

2. Click the Labels tab.
3. Check Label Features.

4. Click the Label Field dropdown arrow and click
STREET NAM.

5. Click OK.

Labeling the roads
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6. Click the File menu and click Save.

If this is the first time you are saving the map document,
navigate to the location where you set up your working
directory (c:\spatial), specify a filename for the map
document (Spatial Tutorial), and click Save.

This brings you to the end of this tutorial. You have been
introduced to some of the functions of Spatial Analyst,
such as learning how to explore your data, producing a
suitability map, and finding the least-cost path.

You have covered much ground, but there is a great deal
more for you to explore. The rest of this book will provide
you with a guide as you learn how to solve your own
specific spatial problems.
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